
dAgent Help Index
This is the index page of HELP for dAgent.
Use the cursor keys or the scroll bar to see the rest of it.

Press F1 for help on using Help.

 Wherever instructions apply only if you are using a Mouse, this icon will be displayed. 

 Similarly this icon indicates that instructions apply only if you are using the keyboard.
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Introduction
dAgent is intended for use by programmers and people of a somewhat technical bent who
use Windows v3.0.    It attempts to describe your Windows setup.

dAgent is a medium model C program written using the Windows SDK and Microsoft C
compiler v5.1.    Four named code segments are used in order to keep memory requirements
down.

dAgent has been tested on a Compaq 386/20e and a Compaq 386/s as well as a number of
clones.    The print out has been tried on a large number of printers and seems robust.



File Menu
The File menu includes commands that enable you to print a report of your system configuration and to 
exit the application.

For more information, select the File menu command name.

Print

Exit



Agents Menu
This menu holds the tools that make dAgent useful.

In order to invoke one of the 9 functions available and listed below listed below use one of the following 
methods :

i) Select the appropriate option from the Tools Menu.
ii) Press the appropriate button.
iii) Press Alt+<underlined letter of option required>.

The Agents menu includes tools that enable you to determine a number of useful things about your 
system as well as to monitor and manipulate it.

Mouser Precisely determines the characteristics of any Window on the screen.
Atoms Permits manipulation of Global Atoms.
General Displays miscellaneous system information.
Stock Objects Displays a sample of each of the Stock Fonts and Stock Fills.
ClipBoard Describes the contents of the Clipboard and allows you to clear it.
SystemMetrics Displays system item sizing information (known as System Metrics) eg Menu Bar height, 

Mouse cursor height and width etc.
Keyboard Displays information concerning your keyboard and mouse, lets you set cursor blink rate, 

mouse speed. Also lets you 'test' the system beep.
DevCaps Displays complete device capabilities for your screen AND every installed device driver in

your Win.ini.
Alerts Displays a sample of each of the Stock Fonts and Stock Fills.



Glossary
Clipboard



Agents Mouser Tool
Similar to the Spy program supplied with the Windows SDK, it 'informs' on any visible window
if you place the mouse cursor over it.    It doesn't however allow you to see all the messages
received by that window but it does give complete window style information as well as a
number of other useful items such as RGB values for client area points, module name and
handle, window name and handle, parent window name and handle etc

N.B. Because the window required for this tool is so large, the main dAgent screen is
minimised for the duration of Mouser and maximised afterwards.    If you wish to move the
mouser information screen in order to view what is underneath, click once on it, move it and
click on it again.    In order to return to the dAgent screen proper, click the right hand mouse
button or use the system menu.

Mouser will not operate if you have not got a mouse.



Agents Atoms Tool
Windows makes extensive use of a sort of semaphore which it calls Atoms. Each has a
name, a number and a use count.    Atoms may either be Global (available to all) or local
(available to your program only).    Atoms may be Added, Deleted (reduce their use count),
'Found' by name or 'Got' by number.    dAgent lets you do all this.    Beware however; a flaw (I
think) in the SDK causes the program to crash if you attempt to 'Get' an atom which does not
exist.



Agents General Information
Displays version, mode, directory and other general information including available memory
and timers.    Note that the Program Manager takes the minimum of the two percentage
figures given for available heap space in the GDI and USER modules when it gives available
memory in 386 Enhanced mode.



Agents Stock Objects Display
Displays a sample of each of the default fonts and brushes available on your system. Useful if you want to
see what they look like on your display.



Agents Clipboard Tool
Describes the current contents of the ClipBoard and allows you to clear it.



Agents System Metrics Information
Single screen showing System Metrics, ie things like default Menu bar height and so on.



Agents Keyboard Information
Describes the keyboard, allows you to set the Mouse double click rate and the
Caret blink rate or swap the mouse buttons. Also lets you test the system Beep (!).

N.B. For some reason I haven't fathomed, the System Metric information concerning the
swapping of mouse buttons is only updated when Windows is restarted; in order to keep
things consistent I update win.ini when you swap the buttons.    This is unsatisfactory but
consistent with the Control Panel, so at least Microsoft had the same problem.



Agents Device Capabilities Information
Allows you to investigate the Device Capabilities of the all printers installed on your system
as well as the screen.



Agents Alerts Tool
Allows you to monitor the operation of your system. You can set minima and maxima for
each of the items listed below and a period between tests. If any of the limits are broken, a
message box is displayed or a beep sounded to warn you.

The items which can be monitored are as follows :

Disk Space
Memory
GDI Heap space
USER Heap space
Timers available
Number of running Tasks

Note that the shareware version will not monitor available Disk Space on Network drives.



File Exit Command
Ends your dAgent session.



File Print Command
Prints a report of all items made available by the General, Clipboard, System Metrics and Device 
Capabilities tools.



Screen Regions
dAgent displays a window like the one below when you start it up.
This window is divided into 7 regions :

System Menu
Title Bar
Maximize Icon
Minimize Icon
Menu Bar
Tools Area
Sizing Border



Tools Area
The Tools Area in dAgent is the large area in the middle where a button is placed for each tool available. 
Pressing on any of the buttons with your left hand mouse button will invoke the related tool.



Maximize Icon

The Maximize icon is a little box above and to the right of the Tools Area which has an upward pointing 
triangle in it. Selecting this has the same effect as selecting Maximize from the System Menu - it will 
cause dAgent to occupy the entire screen. If dAgent is already occupying the entire screen the triangle 
will be replaced by two smaller triangles, one pointing up and one down; selecting the maximize icon now 
will cause dAgent to be Restored to its former screen size and position.



Minimize Icon

The Minimize icon is a little box above and to the right of the Tools Area which has a downward pointing 
triangle in it. Selecting this has the same effect as selecting Minimize from the system menu - it will cause
dAgent to be reduced to an icon at the bottom of the screen.



Menu Bar
The Menu Bar is situated under the Title Bar and holds the menu commands available within the 
program. dAgent's Menu Bar contains (in order) the File, Agents and Help menus.



Sizing Border
The Sizing border is the thin band running round the outside of dAgent window. Clicking and dragging the 
Sizing border resizes dAgent window.



System Menu
The System Menu is represented by a little box to the left of the Title Bar which has a hyphen in it. 
Selecting it causes the System menu to be displayed.

The System Menu has items on it allowing you to maximize, minimize, size, move or exit (close) dAgent. 



Title Bar
The Title Bar is the strip at the top of the dAgent Window which shows the name of the program and the 
name of the document being edited. 

You can move the dAgent window if you 

1. Click on the Title Bar.
2. Hold down the mouse button and drag the window. An outline will be displayed until you let go of 

the button, when the entire screen will be repositioned.

1. Press Alt+Spacebar.
2. Select Move.
3. Use the cursor keys to move the Window outline around the screen.





Windows Keys
 Choose from the following list to review the keys used in Windows:

Cursor Movement Keys
Dialog Box Keys
Editing Keys
Help Keys
Menu Keys
System Keys
Text Selection Keys
Window Keys



Cursor Movement Keys
Key(s) Function

DIRECTION key Moves the cursor left, right, up, or down in a field.

End or Ctrl+Right Arrow Moves to the end of a field.

Home or CTRL+Left Arrow Moves to the beginning of a field.

PAGE UP or PAGE DOWN Moves up or down in a field, one screen at a time.



Dialog Box Keys
Key(s) Function

TAB Moves from field to field (left to right and top to bottom).

SHIFT+TAB Moves from field to field in reverse order.

ALT+letter Moves to the option or group whose underlined letter matches the one 
you type.

DIRECTION key Moves from option to option within a group of options.

ENTER Executes a command button.
Or, chooses the selected item in a list box and executes the command.

ESC Closes a dialog box without completing the command. (Same as Cancel)

ALT+DOWN ARROW Opens a drop-down list box.

ALT+UP or DOWN ARROW Selects item in a drop-down list box.

SPACEBAR Cancels a selection in a list box.
Selects or clears a check box.

CTRL+SLASH Selects all the items in a list box.

CTRL+BACKSLASH Cancels all selections except the current selection.

SHIFT+ DIRECTION key Extends selection in a text box.

SHIFT+ HOME Extends selection to first character in a text box.

SHIFT+ END Extends selection to last character in a text box



Editing Keys
Key(s) Function

Backspace Deletes the character to the left of the cursor.

Or, deletes selected text.

Delete Deletes the character to the right of the cursor.

Or, deletes selected text.



Help Keys
Key(s) Function

F1 Gets Help and displays the Help Index for the application. If the Help 
window is already open, pressing F1 displays the "Using Windows Help" 
topics.

Pressing F1 when a menu item is highlighted will give context-specific 
help for that item.



Menu Keys
Key(s) Function

Alt Selects the first menu on the menu bar.

Letter key Chooses the menu, or menu item, whose underlined letter matches the 
one you type.

Alt+letter key Pulls down the menu whose underlined letter matches the one you type.

LEFT or RIGHT ARROW Moves among menus.

UP or DOWN ARROW Moves among menu items.

Enter Chooses the selected menu item.



System Keys
The following keys can be used from any window, regardless of the application you are using.

Key(s) Function

Ctrl+Esc Switches to the Task List.

Alt+Esc Switches to the next application window or minimized icon, including full-
screen programs.

Alt+TAB Switches to the next application window, restoring applications that are 
running as icons.

Alt+PrtSc Copies the entire screen to Clipboard.

Ctrl+F4 Closes the active window.

F1 Gets Help and displays the Help Index for the application. (See Help 
Keys)



Text Selection Keys
Key(s) Function

SHIFT+LEFT or RIGHT ARROW Selects text one character at a time to the left or right.

SHIFT+DOWN or UP Selects one line of text up or down.

SHIFT+END Selects text to the end of the line.

SHIFT+HOME Selects text to the beginning of the line.

SHIFT+PAGE DOWN Selects text down one window.

Or, cancels the selection if the next window is already
selected.

SHIFT+PAGE UP Selects text up one window.

Or, cancels the selection if the previous window is 
already selected.

CTRL+SHIFT+LEFT or RIGHT ARROW Selects text to the next or previous word.

CTRL+SHIFT+UP or DOWN ARROW Selects text to the beginning (UP ARROW) or end 
(DOWN ARROW) of the paragraph.

CTRL+SHIFT+END Selects text to the end of the document.

CTRL+SHIFT+HOME Selects text to the beginning of the document.



Window Keys
Key(s) Function

ALT+SPACEBAR Opens the Control menu for an application window.

ALT+Hyphen Opens the Control menu for a document window.

Alt+F4 Closes a window.

Alt+Esc Switches to the next application window or minimized icon, including full-
screen programs.

Alt+TAB Switches to the next application window, restoring applications that are 
running as icons.

Alt+ENTER Switches a non-Windows application between running in a window and 
running full screen.

DIRECTION key Moves a window when you have chosen Move from the Control menu.
Or, changes the size of a window when you have chosen Size from the 
Control menu.





Clipboard

The Windows clipboard is the 'place' that cut and copied text is placed, and where pasted text comes 
from.

The clipboard can be used to cut and paste between different applications as well as within a single 
message or different messages as the clipboard remembers the last cut or copy instruction regardless of 
what else has happened since.



Current Message

The message currently being edited on the screen, it's name is displayed in the blue bar at the top of the 
application window.



Telex

If you don't know what a Telex is, you probably shouldn't be using this program. 



Novell Netware

The most popular network operating system in the world, with around 65% market share.




